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Consider a dataset of 10 residents. Their ID, home type, region, and the number of family members are in a PDF. Well extract the PDF to an Excel file. Method 1 Use Power Query to Extract Data from PDFSteps:In the Data tab, select Get Data and choose From File.Select the From PDF option.A box named Import Data will appear (you may get a
Connecting notification box).Choose the PDF file from which you want to extract the data and click Import. We chose a PDF file called Data.A new dialog box called Navigator will appear.Select the Table001 (Page 1) option to import the table into your worksheet.You will see a preview of the dataset of that page in the Navigator dialog box.Click on
Load.A new sheet will open, entitled Table001 (Page 1), and the data will be extracted into the Excel file as a table.You will get the data in the Excel sheet.Read More: How to Extract Data from Multiple PDF Files to Excel Method 2 Using the Copy Paste FeaturesSteps:Open the PDF.Press Ctrl + A.Press Ctrl + Cto copy the dataset.Open Microsoft
Excel and choose the Blank workbook option to open a blank spreadsheet.Select any cell in that worksheet.In the Home tab, select Paste and choose Paste Destination Formatting.You can also press Ctrl + Vto paste the dataset into the worksheet.Write down a suitable title for your dataset and choose formatting from the Font, Alignment, and Style
available in the ribbon to make your dataset look similar to the PDF.You will get the dataset in your Excel workbook.Read More: Convert PDF to Table in Excel Method 3 Using Microsoft Word Steps: Select the dataset in the PDF file.Press Ctrl + C.Launch Microsoft Word and select the Blank document option.Right-click and choose Keep source
formatting (K) under Paste.If you cant see the whole dataset, click on the move pointer icon on the top-left corner of the table (it will also help you to select the entire table) and choose a suitable alignment.Click the move pointer icon and press Ctrl + C to copy the table.Open Excel.In the worksheet, select any cell and press Ctrl + Vto paste the
dataset.Format the dataset however you like it.Read More: How to Convert PDF to Excel without Software Method 4 Extract Data by Using the Adobe Acrobat Conversion ToolSteps: Open the PDF file in Adobe Acrobat.Select the Export PDF option from the Tools option on the right panel.If the tools option doesnt display on the right side of your
window, it will be on the right side of the Home tab.Choose Spreadsheet and select Microsoft Excel Workbook.Click the Export button.A new window named Save As will appear.Check on the option Open file after export.Choose your desired location to save the Excel file. We chose the Desktop to save the file.Another dialog box will appear.Write
down a suitable name for your Excel file and click Save. We wrote Data as our file name.A small progress bar will be displayed in Adobe Acrobat to show the progress rate of your file exporting.Microsoft Excel will open automatically. Apply your desired formatting to the resulting dataset.You will get your data in an Excel spreadsheet.Read More: How
to Export PDF Comments into an Excel Spreadsheet Download the Practice Workbook Extract Data from PDF.xlsx Related Articles > From File >> From PDF.In the Import Data window, select your file: Export PDF to Excel.pdf.Click Import. Make sure to choose All Files.The Navigator window will open.By default, Excel will convert the PDF file into a
table named Page001.Select Page001 to see a preview of the table.Click Transform Data to edit the table. Step 3: Format a PDF Data Table with the Power QueryThe first row of the table is not necessary.To remove it, select Reduce Rows >> Remove Rows >> Remove Top Rows.In the Remove Top Rows window: Enter 1 in the Number of Rows.Click
OK. Step 4 Load the Dataset in Excel The table will be displayed in the Excel sheet. Method 2 Exporting Data from PDF to Excel using Microsoft WordSelect the dataset in the PDF file and press Ctrl+C to copy the data.Open Microsoft Word and select a Blank document.Right-click and in Paste, choose Keep Source Formatting (K).The dataset in the
pdf file will be displayed in the Word file.Click the Move Pointer icon, and press Ctrl+C to copy the table.In the Excel worksheet, select any cell and press Ctrl+V to paste the dataset.Create a suitable dataset title and use the Font, Alignment, and Style group on the ribbon to format it. Frequently Asked Questions1. Will the exported Excel file keep the
same formatting as the original PDF?Depending on the conversion method and the PDF files complexity, the level of formatting preservation may vary. Simple tables and text formatting are more likely to be converted to Excel accurately. Complex layouts, images, and other formatting elements may not be precisely replicated in the Excel file.2. Can I
convert a scanned PDF to Excel?Yes, you can convert a scanned PDF to Excel, but youll need optical character recognition (OCR) software. With an OCR software text can be recognized from scanned images and converted into editable text. Online and offline PDF converters include OCR capabilities.3. Can I export multiple PDF files to Excel
simultaneously?Depending on the tool or method you use, you may be able to export multiple PDF files simultaneously. In some software applications, you can process files in batch mode or convert multiple files at once, while in others, you must convert files individually. Import PDF to Excel: Knowledge Hub Load To.If you want more control, just
click Transform Data instead of Load. It opens up the table in Power Query Editor. This is where you can clean up those messy headers, fix data types, remove unwanted columns, and merge or split columns. Essentially, it can help make your imported data more usable.Transform data using the Power Query EditorPro tip: I've found this works best
with simple, well-formatted PDFs. Excel sometimes messes up the formatting on multi-page tables. If this happens, try importing one page at a time.If your PDF has complex tables or scanned content, you might want to skip to Method 2.This method is only available to Microsoft/Office 365 subscribers on a Windows device. Method 2: Export PDF data
to Excel using Adobe AcrobatHow to access Adobe Acrobat Pro's Export a PDF featurelf you work with PDFs, chances are you may already have Adobe Acrobat installed on your computer. Its familiar interface and built-in conversion tools make it a convenient next step when Excel's basic import falls short. While it requires a Pro subscription to
unlock the export features, you won't need to learn any new software or install additional tools.Here's how it works:Open your PDF file in AcrobatClick on the Export PDF tool in the right paneChoose spreadsheet as your export format >> select Microsoft Excel WorkbookClick Export (if your PDF is scanned, Acrobat will automatically run text
recognition)Name your Excel file and hit SaveThe best part about Acrobat is its OCR technology. It can handle scanned documents much better than Excel's built-in tool.Pro tip: Acrobat works best when your PDF is properly scanned try to ensure your documents are scanned straight and with good contrast. The biggest limitation is that it exports
everything in the PDF, so you can't selectively choose specific data points or tables. Neither does it support batch processing of multiple PDFs at once. So, if you've occasional PDF conversions that need to processed one at a time, Acrobat is a solid choice.If you're processing large volumes of PDFs daily, you might want to check out Method 3 for a
more automated approach.This method requires an Adobe Acrobat Pro subscription. Full disclosure: I work at Nanonets, so I might be a bit biased here. But after seeing countless organizations struggle with PDF data extraction, I've become convinced that automation is essential for high-volume PDF processing. Let me explain why, and you can
decide if it makes sense for your situation."Of all the solutions we tested, Nanonets did the best job of extracting information from our customer PDFs. Nanonets understood our requirements and provided a solution that integrates easily with our existing setup."David Alldian, Business Analyst atBrown StraussOur Al-powered document processing
platform can handle what traditional PDF converters can't:Complex table structures and layoutsScanned documents through advanced OCRMulti-page PDFs with varying formatsDocuments in any languageHere's how it works:Set up an automatic import of PDF files/data from incoming emails, cloud storage services, support tickets, and just about
any data source.Extract data from PDFs using AI accurately with our advanced Al extractors that dont rely on predefined templates but understand each document contextually.Define rules to identify potential errors, flag specific entries for manual review review, or enhance your extracted/missing data.Export as clean structured data in formats such
as as XLS, CSV, or XML etc. or export into your CRM, WMS, or database directly!The best part? Unlike the manual methods we discussed earlier, you can process hundreds of PDFs simultaneously. Plus, the Al learns from any corrections, so it gets smarter over time.Pro tip: Start with a small batch to help the Al understand your specific document
formats. This builds accuracy from day one.Of course, automation isn't for everyone. If you're only dealing with occasional PDFs, Methods 1 or 2 might be more suitable. But if you're processing volumes of documents (like that clerk I mentioned), automation could save your team hundreds of hours of manual work.I wrote this guide thinking about that
clerk in the government office, and everyone else out there spending countless hours copying and reformatting PDF data instead of doing meaningful work. Whether you choose the quick Excel import, stick with trusty Adobe, or dive into automation, the key is finding what works for your specific situation. We've all been there, and it doesn't have to
be this way.Wondering how Al-powered workflows can help you? [If you're looking for a step-by-step explanation of how to extract data PDF to Excel using VBA, please refer to this post. In there, I explain how you can use VBA to implement the 3 PDF to Excel conversion methods I discuss below, and provide macro code examples.]Most recent
versions of Microsoft Office have several features that allow you to, among others, import data into Excel from the following sources:The most common text file formats, such as comma-separated values (.csv) and text (.txt) files.A Microsoft Access database.A webpage.In some of these cases, the tools you require to do the job are readily available in
Excel's Get External Data group of commands within the Data tab.However, the Get External Data group of commands isn't the topic of this blog post.When the particular file format you're using isn't supported by Excel, importing data may be slightly more complicated.As a general matter, I have no problems with these limitations. You probably
won't encounter such problems very frequently as long as you don't work with obscure file formats that aren't supported by Excel. There is, however, one big exception to this rule.This is a particular file format whose data is not that easy to bring into Excel despite being very popular and widely used:PDF.Portable Document Format (.pdf) files are one
of the most widely used file formats for electronic documents. You probably encounter PDF files at work (almost) every day. In some of those cases, you may need to analyze the data within a particular PDF file with Excel.If you're in such a situation, you may ask:How can you convert a PDF file into an Excel worksheet?You may have also noticed that
successfully converting a PDF file into an Excel worksheet is hard. Doing this requires knowledge of both Excel and PDF.At the same time, the ability to accurately and quickly convert PDF files to Excel is very valuable.My purpose with this blog post is to help you easily convert PDF files to Excel worksheets. Among other things, I explain 3 different
methods you can use to convert a PDF file to Excel and some criteria you can use to determine which method to use. The methods are organized from the simplest (which also returns the less precise results) to the most advanced (usually providing the most accurate conversions).You can use the following table of contents to navigate to the relevant
section where I explain the method that you're interested in. If you're interested in the opposite process (converting Excel files to PDF), I provide a thorough explanation of the topic plus 10 examples of VBA code in this blog post.Before I explain each of the methods that you can use to convert a PDF file to Excel, let's start by taking a look at:What Are
PDF FilesThe acronym PDF stands for Portable Document Format.In very broad terms the PDF format is a digital format that you can use to represent electronic documents. One of the main appeals of the PDF file format is that the document representation is independent of any of the following:Software.Hardware.Operating System.The reason for
this is that the PDF file itself carries the complete description of the document layout and all the information that is necessary to correctly display the electronic document. Therefore, PDF documents allow you (and other users) to:Exchange/Share/View documents;In an easy/reliable/accurate way;Independent of the environment/software/hardware
used to create/view/print the document;While preserving the content/formatting/appearance of the document.In other words: When you use the PDF format to represent a document, the formatting is preserved regardless of the software, hardware or operating system used when the file is opened later.A further advantage of the PDF file format is that
PDF files are compact. PDF reduces file sizes by using:Compression algorithms; andA specific file structure.Considering the above, it isn't that difficult to see why the PDF file format is so widely used. Among other advantages, the PDF format:Retains the intended document formatting; andEnables sharing.This explains why my cheat sheet with
keyboard shortcuts for Excel (which you can get here) is saved (and shared) as a PDF file. The PDF format enables me to set (i) a particular formatting for the document, and (ii) share it with you. Later, once you open the document, you'll see the list of keyboard shortcuts in the format that I originally intended.Microsoft (in the webpage I link to
above) does mention an additional important characteristic of PDF files that, in the end, is what gives rise to the topic of this blog post:Data within a PDF file can't be easily changed.Depending on your perspective, you may consider this to be an advantage or a disadvantage. More precisely:If your main purpose is to prevent (or at least make difficult)
the modification of a particular document, you may be happy that the data within a PDF file can't be easily changed.If you need to work with, and manipulate, the data within a PDF file, you're probably annoyed by how difficult is it to edit a PDF document.Most Excel users, you and me included, found ourselves in the second camp most of the time. We
need to work with the data within the PDF file. Therefore, we usually want to have the ability to convert a PDF file to Excel.l assume that you also want to have the ability to convert PDF files to Excel, so let's take a look at some of the most popular methods to bring data from PDF files into Excel:Method #1 To Convert PDF Files To Excel: Copy And
PasteThe most basic method of bringing data from a PDF file into Excel is to simply copy and paste.Since some (not all) PDF files allow you to copy data, there are cases where you may be able to bring all the data you require into Excel by using the basic commands of copy and paste.Let's take a look at a practical example of how you can copy and
paste data from certain PDF files into Excel:The following screenshot shows a table within a pdf document. More precisely, you can find this table in page 22 of the Working Paper from the European Central Bank titled Inflation forecasts: Are market-based and survey-based measures informative? by Magdalena Grothe and Aidan Meyler.Throughout
this blog post, I show the results obtained when applying each of the different methods to convert this table from PDF to Excel. This Convert PDF to Excel Tutorial is accompanied by an Excel workbook containing these results. You can get immediate free access to this example workbook by subscribing to the Power Spreadsheets Newsletter.Step #1:
Select And Copy The DataThe first step to copy data from a PDF file is to, simply, select the relevant data and copy it. You can generally use the Ctrl + C keyboard shortcut for purposes of copying data.Step #2: Paste The Data Into ExcelOnce you've copied the relevant data from the PDF file, and this is available on the Clipboard, you need to go to
Excel and paste it.Even though this sounds easy, in practice it doesn't work that smoothly. In fact, this step highlights some of the main limitations of this method of converting PDF files to Excel.You may want to consider:Using the Paste Special command; andTrying some of the different options that appear.You can access the Paste Special dialog box
by:#1: Clicking on the drop-down section of the Paste split button in the Home tab of the Ribbon; and#2: Selecting Paste Special.You can also open the Paste Special dialog box by using the keyboard shortcut Ctrl + Alt + V.In the Paste Special dialog box, you can choose from several options. The following image shows how the Paste Special dialog
box looks like when I paste the data from the PDF table that appears above:For this example, I select the option to paste as Text and click on the OK button on the lower-right corner of the dialog box.The following screenshot shows the pasted data in the Excel worksheet:In most cases this isn't precisely the result you want. However, you'll rarely be
able to get better results when using this method.As a general rule: Directly copying and pasting from PDF to Excel (usually) results in a single column of data.This is precisely what happens in the example above. And you can generally expect this to happen whenever following this method.As a consequence of the above, you'll usually need to
complete the process with the followingStep #3: Cleanup The DataEven though pasted data in Excel generally requires some cleanup, you have a variety of tools you can use to make the cleanup easier, faster and more precise.Since this blog post isn't about data cleanup, I don't go into any specific methods. However, some of the tools and features
that you may find helpful (depending on the particular situation) are the following: I may cover some of these topics in future tutorials within Power Spreadsheets. If you want to receive an email when I publish new material in Power Spreadsheets, please make sure to register to our Newsletter by entering your email address below:Overall, this first
method of converting a PDF file to Excel leaves some things to be desired. The following are, in my opinion, its 2 biggest drawbacks:Limitation #1: The method only works when you're able to copy the data from the PDF file. As you may have experienced, there are times where you are not able to copy data from a PDF file.Limitation #2: Any data that
you paste into Excel using this method generally unwinds into a single column and requires cleanup. In other words: You may still have to do a substantial amount of work in order to get the data from the PDF file into a form that is ready for analysis.There are some situations in which you may not have any other option for purposes of converting a
PDF file to Excel. This is the case if, for example, you don't have access to any of the tools that are required to apply the other methods that I explain below.In any case, as long as you have access to a recent version of Microsoft Word or to Word Online, the following method may help you achieve better results when converting a PDF file to
Excel.Method #2 To Convert PDF Files To Excel: Use Microsoft WordIn order to make use of this method, you need access to one of the following:One of the most recent versions of Microsoft Word (2013 or later).Access to Microsoft Word online and OneDrive.In broad terms, the logic behind converting a PDF file to Excel is the same regardless of
which of the above versions of Word you use. You, basically, follow these 2 simple steps:Step #1: Open the relevant PDF file using Microsoft Word.Step #2: Copy the relevant content from the Microsoft Word file and paste it into Excel.However, let's take a more detailed look at each of these methods to convert a PDF File to Excel using Word. In both
cases, I use the same sample table as above, which you can find in page 22 of the Working Paper from the European Central Bank titled Inflation forecasts: Are market-based and survey-based measures informative?.Convert PDF File To Excel Using A Recent Version Of Microsoft WordLet's start by taking a look at how you can use a recent version of
Microsoft Word to convert a PDF file to Excel:Step #1: Open The PDF FileYou can open the PDF file you want to convert using any of several methods, including the following 2:Method #1: On the Windows File Explorer: (i) Right-click on the PDF file to expand the right-click menu, (ii) select Open with, and (iii) click on Word. In the case of the
screenshot below, I open the file using Word 2016 on Windows 10.Method #2: Follow these 3 easy steps:Step #1: Within Word, click on the File tab of the Ribbon to get to the Backstage View.Step #2: Select Open from the pane on the left side of the screen and click on Browse.Step #3: Once Word displays the Open dialog box, (i) navigate to the
folder where the PDF file is stored, (ii) select it, and (iii) click on the Open button on the lower right corner of the dialog.If you prefer using keyboard shortcuts to get to the Open dialog box, you can replace steps #1 and #2 above with a keyboard shortcut such as Ctrl + F12 or Alt + F + O + O.After you've asked Word to open the file, a dialog box
(such as the one below) is displayed. This dialog box informs you about the following:The PDF file will be converted to an editable Word document. This is perhaps the main key for the whole process of converting a PDF file to Excel using this method.The conversion may take a while. This depends on different factors, such as the size of the file you're
converting and the amount of graphics within the file.The resulting Word document is optimized to allow text edition. As a consequence of this, the converted Word file will likely look different from the source PDF. This is very likely, in particular, if the file you're converting has many graphics.When Word displays this dialog box, click on the OK
button.As mentioned above, the conversion may take a while, so you may have to wait a little before proceeding to the next step.Step #2: If Necessary, Enable Editing Of The FileDepending on the source of the PDF file, Word may open it in Protected View.To exit Protected View, follow these 2 easy steps:Step #1: Click on the Enable Editing button
that appears on the Message Bar.Step #2: Word usually displays (as in step #1 above) a message box informing you that Word will convert the PDF file to an editable Word document. When this dialog box appears, click the OK button again and wait until Word completes the conversion process.Step #3: Copy The Relevant Sections Of The Editable
Word DocumentOnce you've completed step #1 and (if necessary) step #2 above, Word displays the original PDF file as an editable Word document.When you have the editable Word document, select the section that you want to take into Excel. In the example below, I select the same table as in the previous method:Once you've selected the relevant
information in the editable Word document, copy it. For these purposes, you can use any of the following methods:Method #1: Press the right button of the mouse and select Copy from the contextual menu.Method #2: Click on the Copy button in the Home tab of the Ribbon.Method #3: Use a keyboard shortcut such as Ctrl + C.Step #4: Paste In
ExcelBy now, you have the information you need in an editable format. Therefore, you can go to Excel and paste it by using, among others, any of the following methods:Method #1: Press the Paste button in the Home tab of the Ribbon.Method #2: Use the Ctrl + V keyboard shortcut.In the example above, the resulting table (once pasted in Excel)
looks as follows:In some cases, including this example, the conversion from PDF to Excel isn't perfect.Notice, for example, how Word hasn't been able to convert the values in the first section of the table (Mean error) to an editable form. In this case, those values are pasted as an image. Therefore, you must use another method (including those
described in this Excel tutorial) to bring them into Excel before being able to work with them.You won't encounter these shortcomings always. In some cases, this method works just fine.However, the feature Word uses to convert PDF files to Word documents (called PDF Reflow):Works best with simple files that contain (mostly) text.Doesn't handle
more complex elements (for ex., tables with cell spacing) very well.If you encounter problems while using Word to convert a PDF file to Excel, you can always try one of the other methods I describe in this blog post.Convert PDF File To Excel Using Microsoft Word OnlineEven though the process for converting a PDF file to Excel using Word Online is
substantially similar to that I followed when using the desktop version of Word, there are a few small differences. Let's take a look at the 5 easy steps you can use to convert a PDF file to Excel using Word Online.Step #1: Upload The PDF File To OneDriveGo to OneDrive and upload the PDF file you want to convert to Excel using either of the following
methods:Method #1: Dragging the relevant file to the OneDrive window in your browser.Method #2: Saving the PDF file in the appropriate folder using the OneDrive app for your computer.Step #2: Open The PDF File Using Word OnlineTo open the PDF file using Word online, go to the OneDrive window in your browser, right click on the file and
select Open in Word Online from the contextual menu.Step #3: Make The PDF File EditableOnce Word online has opened the PDF file, convert it into an editable document by clicking on the Edit in Word button in the upper part of the screen.Word online displays a dialog box informing you that it will make a copy of the PDF file and convert it into an
editable Word document. Confirm by clicking on the Convert button on the lower part of the dialog box.Once Word online has finished the conversion, it displays another dialog box informing you changes in the layout of the PDF file may have occurred. Click on the Edit button on the lower right corner of the dialog box.Step #4: Copy The Section Of
The Document You Want To Take To ExcelOnce Word online has converted the PDF file to an editable document, the screen looks roughly as follows. The actual document will (most likely) be different in your case.Go to the section of the editable document that you want to bring into Excel, and select it. In the screenshot shown below, I select the
same table I use for the previous examples within this Excel tutorial:Once you've selected what you want, copy it by using the keyboard shortcut Ctrl + C.If you have problems when trying to copy from Word online, you can use the desktop version of Microsoft Word in your computer to continue with the process. To do this, click on the Open In Word
button that appears to the right of the Ribbon tabs.If you choose to open the editable file in Microsoft Word, the desktop version of Word is launched. You can then follow the steps I describe in the previous section to copy the relevant data.Step #5: Paste The Data In ExcelOnce you've copied the data, go back to Excel and paste it by using (among
others) one of the following methods:Method #1: Click on the Paste button.Method #2: Use the Ctrl + V keyboard shortcut.The following screenshot shows the resulting table in Excel (after I've adjusted the column width):Not surprisingly, the results are almost identical as those obtained by opening the PDF file with a recent version of Microsoft
Word (explained above).Just as when opening the PDF file with Microsoft Word, you'll notice that the results aren't always perfect (although in some cases they will be). In the case of the example displayed above, for example, all the Mean errors (first section of the table) are pasted as an image.In order to be able to manipulate those values in Excel,
you'll need to bring them using another method (such as the other ones explained in this blog post) or type them directly in Excel.Method #3 To Convert PDF Files To Excel: Use A PDF ConverterIf you have to constantly convert PDF files to Excel or want to avoid the shortcomings of the other 2 methods described above, it may be a good idea to use a
PDF converter.There are several PDF converters in the market. I use Able2Extract.Even if you don't end up using Able2Extract, you may want to steer clear of online PDF conversion services when converting sensitive or confidential PDF files. In addition to potential privacy/confidentiality concerns, the results obtained with online converters aren't
always satisfactory.As a consequence of the above, I show you how to convert a PDF file to Excel using Able2Extract. As when explaining the other methods above, I use the table within the European Central Bank Working Paper titled Inflation forecasts: Are market-based and survey-based measures informative? as an example.Let's take a look at
how you can convert a PDF to Excel in 6 easy steps when using Able2Extract:Step #1: Display The Open Dialog BoxIn order to get Able2Extract to display the Open dialog box, click on the Open button on the top left corner of the screen or use the Ctrl + O keyboard shortcut.Step #2: Open The File You Want To ConvertOnce Able2Extract displays the
Open dialog box, use it to browse to the folder where the file you want to convert is located.Once you've located the PDF file to be converted, select it and click the Open button on the lower right corner of the Open dialog box.Step #3: Select The Data You Want To ConvertAble2Extract opens the PDF file you want to convert. It also explains how you
can select the data you want to convert.As explained by Able2Extract, you can select data using any of the following methods:Method #1 To Select Data With Able2ExtractClick on the Select All icon on the toolbar.Method #2 To Select Data With Able2ExtractGo to the Edit menu and select any of the following options or use the appropriate keyboard
shortcut:Let's take a look at each of these options separately:Option #1: Select Page RangeSelect Page Range (keyboard shortcut Ctrl + R) allows you to select a particular range of pages, without actually selecting all of the content of the PDF file.Able2Extract displays the Select Page Range dialog box after you've clicked on Select Page Range in the
Edit menu or used the Ctrl + R keyboard shortcut.You determine the pages to be converter by typing the relevant range and clicking on the OK button on the lower section of the Select Page Range dialog box. For example, to convert pages 21 and 22, you'd enter 21-22 and click OK.Option #2: Select All Pages.The Select All Pages option (keyboard
shortcut Ctrl + A) allows you to select all of the pages of the PDF document.Option #3: Select All on Page.Select All on Page (keyboard shortcut Ctrl + B) selects all the data in the current page of the PDF file.Option #4: Select Area.The option to Select Area (keyboard shortcut Ctrl + *) allows you to use the mouse to select a particular section of the
PDF file to convert.For example, I can use this option to select the table in page 22 of the European Central Bank Working Paper that I use as an example throughout this blog post.Method #3 To Select Data With Able2ExtractThe third way of selecting data with Able2Extract is very similar to using the Select Area option in the Edit menu. Simply use
the mouse to select the portion of the PDF document that you want to convert.Step #4: Select Excel As Output File TypeOnce you have selected the data you want to convert from PDF to Excel using any of the methods explained above, click on the Excel button on the toolbar or use the keyboard shortcut Ctrl + E to select Excel as the output file type
for the conversion.Step #5: Click On ConvertOnce you've clicked on the Excel button of the toolbar, Able2Extract provides you 2 options regarding the way in which you want the conversion to occur:Option #1: Automatic.This is the default option, and is also the recommended choice for most PDF to Excel conversions. If you choose this option,
Able2Extract determines the positioning of the columns automatically.To choose Automatic conversion, click on the Convert button that appears on the lower left section of the Convert to Excel dialog box.Option #2: Custom.In the special cases where the Automatic conversion doesn't work properly (for example, the resulting Excel table isn't properly
aligned), you can use the Custom conversion option to specify the column structure. This allows you to designate the column structure before Able2Extract carries out the actual conversion into Excel.To use the Custom conversion option, click on the Define button on the lower middle section of the Convert to Excel dialog.For this particular example, I
choose Automatic conversion. I may explain how to use the Custom conversion option in a future blog post.Step #6: Save The Excel SpreadsheetAfter you click on the Convert button to use Automatic conversion, Able2Extract displays the Save As dialog box.Use this dialog to select the location and filename of the converted Excel file, and click on the
Save button on the lower right corner to confirm your choice. Notice how the Save As dialog box is saving the resulting file as an Excel Spreadsheet.Once you click on Save, Able2Extract converts the selected section(s) of the PDF file into Excel, and launches Excel.The results I obtain when converting the sample table are shown in the screenshot
below. Notice how, among others, Able2Extract was able (i) to replicate the table structure and (ii) extract all of the significant values from the source PDF document.There's still some cleaning up work to be done. Notice, for example, how negative numbers have been extracted as text (I highlight one such value below).These are, however, small
issues that are relatively easy to fix.For example, the negative numbers that are stored as text can easily be converted into actual numbers by using the VALUE function and, if necessary, Excel's text functions.If you're interested in using Able2Extract to convert PDF documents to Excel files, you can download it, and get a 7-day free trial, by following
the link below:Download Able2Extract (affiliate link)How To Convert PDF Files To Excel: Which Method To Useln this blog post, you have seen 3 different methods to convert a PDF file to Excel:Method #1: Copy and paste.Method #2: Use Microsoft Word.Method #3: Use a PDF converter.You may be wondering which of the 3 methods that I explain in
this blog post should you use when converting PDF files to Excel.Each of the 3 different methods has different advantages and disadvantages.As a general matter, the results obtained when copying and pasting data from a PDF file to Excel (method #1) are (in my opinion) not particularly good. Therefore, in most situations, you're likely to be better off
using Microsoft Word (method #2) or a PDF converter (method #3).For purposes of choosing between Microsoft Word (method #2) and a PDF converter (method #3) for purposes of converting PDF files to Excel, I suggest you consider the specific situation you're in and, particularly:The length and complexity of the PDF data you want to convert to
Excel.If you constantly convert lengthy or complex documents from PDF to Excel, you may want to consider using a PDF converter such as Able2Extract.How often (or how many times) do you need to convert PDF files to Excel.If you find yourself constantly carrying out the process of converting a PDF file to Excel, a PDF converter (such as
Able2Extract) may come in handy.An additional factor to consider is that, as shown in the examples above, a good PDF converter (like Able2Extract) is less prone to introducing errors in your data. Some of the manual conversion methods may introduce errors in your data and you will need to carry a more thorough re-check to confirm the accuracy of
the conversion.The following rule of thumb may help you choose between Microsoft Word and a PDF converter (for your PDF file conversion needs):Microsoft Word tends to work well when converting shorter, simpler documents.PDF converters (for ex., Able2Extract) tend to be the better option when dealing with longer, more complex (for ex., tables,
repeating headers or footers) documents.This Convert PDF to Excel Tutorial is accompanied by an Excel workbook containing the results I obtain when using each of the methods to convert PDF files into Excel I cover above. You can get immediate free access to this example workbook by subscribing to the Power Spreadsheets Newsletter. This
workbook contains 4 different worksheets, each of them shows the results of each of the conversion methods I explain above.ConclusionAfter reading this blog post you have a good knowledge about 3 of the most popular and common methods to convert PDF files to Excel:Copy and paste.Use Microsoft Word.Use a PDF converter, such as
Able2Extract.You've also seen some criteria that can help you decide which method is the right one for you and learned more about the relationship between PDF and Excel files.This knowledge will help you to convert PDF files to Excel worksheets quickly and easily. You're also likely to start seeing new possibilities and opportunities for analyzing
data or carrying other analysis that you didn't do before because, for example, the source data was stored in PDF format. Download Article Easily import tables from a PDF into your Excel worksheet Download Article Do you have a PDF table that you want to add to an Excel sheet? If you try copying the table from the PDF and then pasting it into
Excel, you'll get jumbled and non-sensical text. Fortunately, it's easy to copy a table from a PDF to Excel if you have Microsoft 365 (Office 365) for Windows. If you're using a Mac or have an earlier version of Excel, you can still copy and paste the table by opening the PDF in Microsoft Word. This wikiHow article will teach you two simple ways to copy
a table from a PDF to an Excel workbook. With a Microsoft 365 subscription on Windows, you can use Power Query to import a table from any PDF.You can also open a PDF in Word and enable editing to copy the table into an Excel worksheet.When you paste a PDF table into Excel with either method, the data will be organized into columns and rows
just as it was in the PDF. [1]10pen Excel on your Windows PC. You can open a new project or continue a saved project in Excel.This method covers using the Power Query feature to import a table from a PDF into Excel. This feature is only available with a Microsoft 365 (Office 365) subscription on Windows. Unfortunately, this feature is not yet
available on Excel for Mac.[2] 2Select a cell. Click the cell into which you want to begin pasting the table. For example, click Al to begin pasting the table at the upper-left corner of the sheet. Advertisement 3Click the Data tab. It's in the menu above the editing ribbon.4Click Get Data. For Windows, it's the furthest icon on the left of the menu.5Select
From File and choose From PDF.[3] With each selection, the menu will continue expanding until you select From PDF, after which Excel will open your file manager (Finder for Mac and File Explorer for Windows).6Select your PDF and click Open. Excel will connect to the PDF file and display a list of tables.7Select a table to copy. In the left panel,
click the table you want to import. You can click through each table to see a preview in the right panel. To copy multiple tables into your Excel workbook, check the box next to "Select multiple items" at the top. Knowing the page number on which the table you want is located in the PDF will be helpful, as each table is labeled by page number.8Click
Load. It's in the bottom right corner. This copies the table from the PDF to the current worksheet in Excel.If you'd rather work with the table data in Power Query before copying it to your worksheet, click Transform Data instead.[4] Advertisement 10pen the PDF in Microsoft Word. If you're not using Microsoft Office 365 on a Windows PC, the easiest
way to copy a table from a PDF into Excel is to first open the PDF in Word. This method will work in any version of Excel beginning with Office 2013 on a PC or Mac. To open the PDF in Word:Open Microsoft Word.Click the File menu and select Open. If you don't see a File menu, just click Open.Select the PDF that contains the table and click Open.
[5]Click OK when prompted to convert the PDF into a Word document. It may take a few moments to display the file.2Use your mouse or trackpad to highlight the table you want to copy. Now the PDF is in the Word format, it should be easier to copy while retaining the original table structure.3Click the Enable Editing button. You'll see this in the
alert bar at the top of the file. This allows you to edit the document.If prompted, click OK again to make the file editable.4Select the table you want to copy to Excel. If Word recognizes the table in the file, you'll see a crosshair icon at the table's top-left corner. In this case, just click that icon to select the entire table at once. If Word doesn't recognize
the table, use your mouse or trackpad to select the table you want to copy.5Press Ctrl+C (PC) or Cmd+C (Mac) to copy. The table is now copied to your clipboard.60pen your Excel sheet and click a cell. Click the cell into which you want to begin pasting the table. For example, click A1l to begin pasting the table at the upper-left corner of the sheet.
7Press Ctrl+ Shift+V (PC) or Cmd+ Shift+V (Mac) to paste. This copies the table data into the sheet without pasting any special colors or formatting from the PDF. This is a great way to paste if you want the data from the table to be plain text or automatically inherit the formatting of your Excel sheet.If you'd rather keep the formatting of the original
table, such as custom colors, fonts, and bold text, you can use Ctrl + V (PC) or Cmd + V (Mac) instead. Advertisement Ask a Question Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Nicole Levine, MFA. Nicole Levine is a Technology Writer and Editor for wikiHow. She has more than 20
years of experience creating technical documentation and leading support teams at major web hosting and software companies. Nicole also holds an MFA in Creative Writing from Portland State University and teaches composition, fiction-writing, and zine-making at various institutions. This article has been viewed 290,116 times. Co-authors: 5
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